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Getting Started 
This guide shows you how to set up your PC with GoToMyPC Personal and access it from 
another computer. It also explains the main features of GoToMyPC Personal so that you can 
begin working quickly. 

 

System Requirements 

Host PC: 

•  Required: Windows 95, 98, 2000, Me, NT, XP and Server 2003 

•  Required: Internet Explorer, Netscape Navigator 4.0 or later or Mozilla Firefox 1.0 or later 

•  Required: "Always on" Internet connection (cable, ISDN, DSL or better) 

•  Recommended: Minimum of Pentium 300 with 64 MB of RAM 

Client computer with GoToMyPC Viewer and full features: 

•  Required: Windows 95, 98, 2000, Me, NT 4.0, XP or any operating system that has a Java-
enabled browser 

•  Recommended: Internet Explorer, Netscape Navigator 4.0 or later or Mozilla Firefox 1.0 or 
later with all Java components enabled 

•  Recommended: Broadband Internet connection (cable, ISDN, DSL or better) 

•  Recommended: Resolution same or higher than the Host computer 

Client computer with GoToMyPC Universal Viewer and limited features: 

•  Mac OS 8.6 through 9.2; IE 5.0 with MRJ version 2.2.5 and above 

•  Mac OS 10.1 through 10.2.4; IE 5.1 and above 

•  Linux Kernel 2.1 and above; Netscape 4.7 and above 

•  Solaris 5.7, 7, 8; Navigator 4.7 and above 

•  Win 95/98/2000/ME/NT4/XP; Navigator 4.7 or IE 5 or above with a Java Runtime installed 

Client device with GoToMyPC PocketView™ and limited features: 

•  Microsoft Pocket PC 2002 

•  Microsoft Pocket PC 2002 Phone Edition 

•  Microsoft Windows Mobile 2002/2003/2003SE 

•  Microsoft Windows Mobile 2002/2003/2003SE Phone Edition 

•  Most devices running Microsoft Windows CE 4.0 or later 
 
 

Notes on Installation and Feature Access 

Please keep the following information in mind when installing and using GoToMyPC: 

•  Because of various operating system restrictions, some features of GoToMyPC Personal 
require the service to be installed on the Host PC with administrator rights enabled. 

•  Because of various operating system restrictions and hardware requirements, some 
features of GoToMyPC Personal may not function on some computers. Please see notes in 
each feature description to determine which features may or may not work on your Host 
PC. For Server 2003 as a host PC, the www.gotomypc.com Web site must first be added 
as a trusted site. 
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Terms 

Host PC - The Host PC is the computer you will want to access from a remote location. You 
will install the GoToMyPC Personal software on the Host PC. The Host PC is a unique 
and specific computer. 

Client Computer - The Client computer is the computer you will use to access your Host 
PC. It can be any computer anywhere in the world that is connected to the Internet 
(airport kiosk, Internet cafe, hotel, library, etc.). 

Computer Nickname - The computer nickname is the name you assign to a Host PC when 
you download the GoToMyPC Personal software. Using nicknames helps you identify 
your computers if you set up more than one for remote access. It can be any name you 
choose: Office, Home, Laptop, Rover — you decide. 

Account Password - Your account password is what you use to log in to the GoToMyPC 
Personal Web site. It must be at least eight characters and contain both letters and 
numbers. You will use your account password to log in to the GoToMyPC Personal Web 
site and set up a Host PC. 

Computer Access Code - Your computer access code is the unique password that you set 
up for each Host PC. It must be at least eight characters and contain both letters and 
numbers. You will use the access code every time you log in to a Host PC.  

Viewer - The Viewer is the window displayed on your Client computer in which your Host 
PC's desktop will appear. The Viewer window has its own title and menu bars. 

Host PC image - The Host PC image is the picture of the Host PC desktop that appears in 
the Viewer window.  

System tray icon – The system tray icon represents the status of the GoToMyPC service 
and is used to access GoToMyPC preference and setting options. To access system 
preferences, right click the system try icon and select Preferences. 

Status state representations 

Icon Status 

 GoToMyPC host PC is running and ready for use 

 GoToMyPC host PC requires authorization before use may begin 

 GoToMyPC host PC is running but connection is interrupted 

 GoToMyPC host PC is being accessed in a session 

 GoToMyPC host PC has screen-blanking enabled while in a session 

One-Time Passwords – One-Time Passwords offer an additional level of security for 
users. This feature will help defeat keyboard-sniffer or keystroke logger software. 
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Features 
 

 

Automatic Setup: Plug-in automatically launches, installs and configures 
itself. No restart required. Set up and ready to go in minutes, even by novice 
users. 

 

Universal Viewer: When you connect to your PC, the Viewer window 
launches automatically, allowing you to view and control your PC from another 
Windows, Windows CE, Mac, Linux, Unix or Solaris computer. No pre-loaded 
software required. Access your PC from any Web browser on any operating 
system at any time. Even work on your office Windows PC from your Mac at 
home. 

 

PocketView™ Wireless Access: Securely access your PC from your wireless 
Pocket PC device running Windows Mobile 2002/2003/2003SE or from your 
device running Windows CE 4.0 or later. Provides ultimate mobility. 

 

File Transfer: Easily transfer files, folders and directories between computers. 
You never again need to email files to yourself or copy to floppies. Get access 
to your files at any time from anywhere. 

 
Guest Invite: Invite a second person to temporarily view or share control of 
your PC. Great for tech support, demos or "conference" viewing of info. 

 

Remote Printing: Print documents to any printer wherever you happen to be 
– there's no need for the application that created the document to be installed 
on the client computer. A hard copy of that forgotten file is only a connection 
away. 

 
Cut and Paste: Cut, copy and paste text between computers. Simplifies 
transfer of content between desktops. 

 

Encryption and Maximum Security: All data is protected with AES 
encryption using 128-bit keys. Dual passwords and end-to-end user 
authentication. Option to use One-Time Passwords for maximum security. Most 
secure Internet connection available in a remote-access product. 
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Setting Up GoToMyPC 
Before you can access your PC remotely, you’ll first need to create your account (first time 
users), install the GoToMyPC Personal software and leave the PC accessible. To do this, you 
will need to be at the PC and have the email address and password you used to register. 

Note: To enable all features and functionality, GoToMyPC Personal needs to be installed with Administrator Rights. 

Create Your Account (first time users) 

 To create your account 

1. Go to your email account and open the email titled Set Up GoToMyPC. 

2. Click the link in the email to activate your account (first link in email). A new browser 
window opens and prompts you to create your account. 

3. Enter your first and last name, create and confirm your account password, click Submit. 

Set Up Your Host PC 

 To set up a Host PC for remote access 

Step One - Download the software 

1. Be at the PC that you will want to access remotely; this will be the Host PC. 

2. Open a browser window and go to www.gotomypc.com. In the Returning Users section, 
enter your Email address and account Password and click the Log In button. 

3. First-time users, or users without any PCs set up, click the Install GoToMyPC button.  

4. Returning users who already have a Host PC set up, click the Add Computer button or 
the Enable this Computer link, and then click the Install GoToMyPC button. 

5. Click Yes or Grant to begin downloading the GoToMyPC Personal software. 

Step Two - Install the software 

1. The Install Shield Wizard will begin automatically. Select the default destination for the 
GoToMyPC Personal software installation and click Next. 

2. Click Finish to complete the GoToMyPC Personal installation. 

3. When prompted, enter your Email address and account Password (these are the same 
that you use to log in to the GoToMyPC Personal Web site) and click OK. 

4. When prompted, enter a computer Nickname for the Host PC; if needed, select the 
Group to which this computer should belong. Give the PC an Access Code, confirm the 
Access Code and click OK. 

5. On the Setup Complete notification box, click OK. The  icon will appear in the System 
tray to let you know that the service is running. 

Note: If you are a GoToMyPC Personal user in an environment that requires authentication to access the 
Internet, you will be prompted to enter your GoToMyPC Personal account log in information during setup. 

Leave Your Host PC Accessible 

To be able to access your Host PC from a remote Client computer, you need to ensure that 
your Host PC meets the three following conditions: 

1. The Host PC is turned on. 

2. The Host PC is connected to the Internet with a live connection. 

3. The GoToMyPC Personal service is running. 

Note: To help ensure the security of your PC, you may want to lock it with a screensaver password (Windows 
95 /98/Me/XP Home) or by using the Ctrl-Alt-Delete function (Windows NT/2000/XP Professional) before 
leaving the PC.  
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Accessing Your GoToMyPC Personal Host PC 
Once GoToMyPC Personal is set up and running on your Host PC, you can access it immediately 
from almost any other Client computer with Windows or a Java-enabled browser that is 
connected to the Internet, such as from computers at airport kiosks, Internet cafes, hotels, 
etc. 

To remotely access your Host PC, you’ll need to be at a Client computer (any computer other 
than the Host PC you just set up) and you will need to know your email address, password and 
access code. 

Access Your Host PC 

 To remotely access your Host PC 

1. In your Web browser, type www.gotomypc.com. 

2. Enter your Email address and account Password and click Log In. 

3. If prompted, choose the account you want to access and click Go (only applies if you 
have multiple accounts associated with one email address). 

This will load your My Computers page. 

4. To the right of the Nickname of the PC to which you want to connect, click the Connect 
button.  

5. When prompted, Click Yes or Grant to download the GoToMyPC Personal Viewer. 
PocketView users will need to click the Download link to begin download. 

6. When prompted, enter the Host PC's Access Code and click OK. 

7. The Host PC image will appear in the Viewer window. 

You are now connected to your Host PC and are ready to start accessing all your files, 
applications and email as if you were sitting at your PC! 

Note:  If a PC's status is Offline, then you will not be able to access that Host PC. To access a Host PC, you 
need to leave the PC on and connected to the Internet with GoToMyPC Personal running.  If the PC is a shared 
PC and it is being accessed by another GoToMyPC user, “In Session” will appear next to the connect button. If 
you chose to connect to a PC while it is in session, the session in progress will be terminated. Keep in mind 
that the In Session notification will display until the first user terminates the connection with the host PC and 
you refresh your browser. 

 
 

Remotely Unlock Your Host PC  

If you locked your Host PC after previous use, you will need to remotely unlock it when you 
connect. Your operating system determines the unlock method. 

 To unlock Windows NT, 2000 or XP Professional use the Lock Workstation function 

1. Remotely connect to your Host PC. 

2. From the Viewer menu, choose Tools, then Send Ctrl-Alt-Del. 

Launches Unlock Computer window on the Host PC. 

Or click the Send Ctrl-Alt-Del button in the upper right-hand 
corner of the viewer window. 

 
3. Log in to your PC as you normally would using your network ID 

and Password. 

Note: To use the Lock Workstation function to unlock your Host PC, you must install GoToMyPC Personal as a 
service, which will require administrator rights for your profile.  
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 To unlock Windows 95, 98, Me or XP Home use the Screensaver Lock function 

1. Remotely connect to your Host PC. 

2. Once you are connected and the Viewer window displays the image of your Host PC 
desktop, move your mouse to get the screensaver password prompt. 

Launches screensaver log-in prompt. 

3. Log in to your PC as normal using your screensaver password. 
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The GoToMyPC Personal Viewer 
 

Resize Your Viewer Window 

You can choose to have the Viewer appear as a window on your desktop or as a full-screen 
image. 

! In Window mode: The Viewer will appear as a window on your desktop just like any 
other application. You will always be able to see the Viewer menu bar and the Windows 
controls in the upper-right corner of your screen as well as be able to resize the Viewer 
window just like any other application window 

! In Full Screen mode: The Viewer will expand to full screen and the menu will auto-hide 
at the top of the screen. A tab the same color as your Viewer window will be displayed 
at the top of the screen; this tab will enable you to access the Viewer menu bar when 
needed 

 

 To start Full Screen mode 

! From the Viewer window menu bar, select View, then Full Screen. 

This will expand the Viewer window to Full Screen. 
 

 To end Full Screen mode 

1. Move your mouse over the Viewer window tab at the top of the 
screen. 

The Viewer menu will display. 

2. Select View, then Window.  

This will cancel the selection of Full Screen mode and return you to a 
resizable Viewer window. 

 

Resize Your Host PC Image 

You can choose to change the size of the image of your Host PC desktop within the Viewer. You 
have the options of choosing to adjust your image size to Actual Size, Scale to Fit or Zoom To. 

! Actual Size: Displays the actual image of the Host PC 
desktop within the Viewer and may require you to scroll. 

! Scale to Fit: Displays the image of the Host PC desktop 
scaled to fit the whole desktop image within the Viewer. 

! Zoom To: Allows you to zoom the image to a setting you 
choose. You can choose from several pre-set options or 
choose a custom option. This selection may require you to 
scroll. 

 

 To resize your Host PC image 

1. From the Viewer window menu bar, select View and then 
your preferred image size: 

•  Actual Size 

•  Scale to Fit 

•  Zoom To 
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Universal Viewer 

The Universal Viewer enables you to view your Host PC from any computing device and 
operating system that supports Java, including Mac, Linux and Solaris computers or from 
Windows computers that do not accept downloadable files.  

This feature is particularly useful if you are using an Internet kiosk. To help ensure the 
greatest possible usability, the Universal Viewer has a limited set of features and does not 
include Desktop Shortcut, Chat, Draw, Clipboard, Remote Printing, File Transfer and 
Viewer/Image Scaling/Dimming. 

There is nothing you need to do to enable the Universal Viewer. It will automatically appear 
during the connection process if you are using an operating system other than Windows to 
connect to your Host PC, or if you are using a Windows PC that does not accept downloadable 
files. 

To help ensure your security when using the Universal Viewer, you will be logged out of your 
GoToMyPC Personal My Computers page anytime you navigate to a new Web page, exceed 
your Viewer inactivity time-out period without any keyboard or mouse activity or disconnect. 

 

Note: To use the Universal Viewer, the Client computer must have Java Virtual Machine (Microsoft VM) installed and 
one of the following operating system/browser combinations: Mac – Internet Explorer 5.0; Linux - Netscape 4.7; 
Solaris - Netscape 4.7; Win - Netscape 4.7 or Internet Explorer 5. The Host PC requires a Windows operating system, 
an Internet connection and GoToMyPC Personal software installed and running. 
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GoToMyPC Personal PocketView 
 

PocketView™  

GoToMyPC PocketView enables you to securely access your Host PC from your compatible 
handheld device. GoToMyPC PocketView includes support for use of a stylus, scrolling, scaling, 
and portrait or landscape orientation. 

To help ensure the greatest possible usability, GoToMyPC PocketView does not include Desktop 
Shortcut, Chat, Remote Printing and File Transfer. 

There is nothing you need to do to enable GoToMyPC PocketView. It will be automatically 
selected during the connection process if you are using a device with a supported operating 
system to connect to your Host PC. 

 

Note: To use GoToMyPC PocketView, the Client device will need to be running Microsoft Pocket PC 2002, Microsoft 
Windows Mobile 2002/2003/2003SE, Microsoft Windows Mobile 2002/2003/2003SE Phone Edition or Microsoft 
Windows CE 4.0 and above. Please note that performance will depend on the speed of the device’s connection to the 
Internet. 

 

 

 

 

Accessing Your Host PC Using PocketView 

 

When accessing your Host computer using a PocketView compatible device, follow the same 
procedure that is outlined for use with a desktop computer.  

 To remotely access your Host PC 

1. In your Web browser, enter www.gotomypc.com. 

2. Enter your Email address and account Password and click Log In. 

3. PocketView users will need to click the Download link to begin the download. Select the 
checkbox to open the file after download. Overwrite the file if it already exists. 

4. When prompted, enter the Host PC's Access Code and click OK. 

5. The Host PC image will appear in the PocketView window. 

6. You are now connected to your Host PC and are ready to start accessing all your files, 
applications and email as if you were sitting at your PC! 
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The PocketView Toolbar and Menu 

The PocketView Toolbar 

The toolbar appears at the top of the handheld device and enables you to quickly access 
common PocketView features. 

 
 

 

 

 

  

 

 

 

The PocketView Menu 

To display the menu, tap the Menu option on the PocketView toolbar. 

 

 To adjust Host PC image size  

! From the View menu, use the Actual Size, Scale 
to Fit or Zoom To settings 

 

 To adjust Host PC image orientation  

! From the View menu, use the No Rotation, Rotate 
Left or Rotate Right settings 

 

 

 

 

 

 To access PocketView tools 

! Use the Tools menu to access Send Ctrl-Alt-Del, 
Draw Mode, Preferences, and PocketView 
Preferences  

 

 

 

 

Move toolbar 

Show & hide 

 Show menu 

Minimize 

On-screen keyboard 
(tap and hold to choose 
the input method) 

Hover mode 

Right-click mode 

Jump-navigate 
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The PocketView Preferences Dialog 

In addition to the standard GoToMyPC Preferences, PocketView has some per-device settings in 
its PocketView Preferences dialog.  These settings always take precedence over any settings in 
the general GoToMyPC Preferences. 

 

 Initial size  

! The initial size may be set to Actual Size or Scale 
to Fit or it can start in Jump-Navigate mode in 
which the first tap will zoom to that point in 
Actual Size 

 

 Initial rotation  

! The initial rotation may be set to No Rotation, 
Rotate Left or Rotate Right 

 

 Show host computer cursor  

! Shows the mouse cursor 

 

 Large toolbar  

! Increases the size of the toolbar 

 

 Auto-hide toolbar  

! Hides the toolbar after each action 
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Using PocketView 
 

 To quickly scroll to another area on your desktop 
! Tap the Jump-Navigation button on the toolbar to temporarily put the Viewer into fit-

to-screen mode so you can easily see your entire desktop. 

! Next, click the part of the screen where you wish to scroll to and you will be returned to 
your previous zoom level, but centered at the location where you clicked. 

 To scroll Host PC image 

! Tap and hold the stylus on the edge of the screen to scroll in that direction. Scrolling will 
stop when the stylus is released. When dragging a selection on the Host PC, if you drag 
the stylus to the edge of the screen, PocketView will automatically begin scrolling so that 
you can select non-visible areas of the Host screen. 

 To right-click 

! Tap the right-click mode button and the next tap will be a right-click. 

! Or you can use the tap-and-hold gesture to perform a right-click (not all devices support 
this). 

 To move the cursor without left-clicking 

! Tap the hover mode button and the next tap will only move the cursor. 

 To change the soft input panel 

! Tap and hold the on-screen keyboard button to choose an input panel. 

 To create a shortcut to your Host PC 

! Choose File from the PocketView menu, then 
Create Shortcut (not all devices support this).  
The shortcut will be added to your IE Favorites. 

 To disconnect a PocketView session 

! Choose File from the PocketView menu, then 
Disconnect. 

 To restore PocketView (Pocket PC and Windows Mobile devices only) 

! To restore PocketView after minimizing it, choose Start, then Programs and then 
GoToMyPC PocketView. 

Note: For more information about GoToMyPC features, refer to the corresponding sections of the GoToMyPC User 
Guide. 
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PocketView Usage Recommendations 

Choose a device that is appropriate for you: 

1. A Pocket PC, Windows Mobile, or Windows CE device with WiFi will provide the fastest 
access. 

2. A Pocket PC Phone Edition or Windows Mobile Phone Edition device will provide access 
over the largest geographical area. 

3. An external keyboard is recommended if you will be entering text often. 

4. A Windows Mobile 2003SE device with a high resolution (VGA) screen is recommended 
for easiest viewing. 

Optimize your PocketView experience: 

1. Right-click the GoToMyPC icon on your Host computer and select preferences. Under 
the Host tab, turn on the following option: 

•  Automatically adjust the host computer’s screen area 

2. From the Tools menu in PocketView, select PocketView Preferences: 

•  Show the host computer’s cursor 

•  Adjust the other settings to your liking  

3. From the View menu in PocketView: 

•  Set the Zoom to 75%  

•  Select Rotate Left or Rotate Right 

4. From the File menu in PocketView: 

•  Create a Desktop Shortcut to your Host PC 
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Using GoToMyPC Personal Features 
GoToMyPC Personal is easy to use and comes with a complete set of features to help you get 
the most out of remotely accessing your PC. Outlined below are several of the main features 
you’ll want to try. Most of the features are accessible through the Viewer; other features are 

accessible from the  system tray icon, which is usually located in the lower-right corner of 
your screen near the clock. 

Note: If you are a GoToMyPC Personal account user, your ability to access features may be disabled by your 
administrator. If you are unable to access a feature, please contact your administrator for further details. 

 

File Transfer 

File Transfer enables you to quickly and easily transfer files between your Host PC and Client 
computer. 

 To transfer files 

1. From the Viewer menu bar, choose Tools, then Transfer 
Files. 

The File Transfer window opens. The Host PC files are in the 
left pane, the Client computer files on the right. 

2. For the computer you wish to transfer files to, browse to and 
select the folder to store the transferred files. 

3. For the computer you wish to transfer files from, browse to 
and select the file or folder you wish to transfer and either 
click the Transfer button or drag-and-drop the desired files 
to the destination computer. 

4. When the file transfer is complete, click Done. 

 

Note: If you are having difficulty finding the files to send, or finding the files you sent, this is likely due to the use of a 
user profile, which most often occurs with Windows 2000 or NT. To transfer desktop files stored in your profile or to 
find files you transferred to your desktop, you will need to look for the appropriate folder within your user profile. 
Windows 2000 users: go to C: Documents and Settings, then Your User Name, then Desktop. NT users: go to C: 
WINNT, then Profiles, then Your User Name, then Desktop. 
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Chat 

Chat is a function that enables you to start a chat dialog with a guest you have invited to your 
PC. 

To communicate with Chat, simply enter your text into the text entry field and click Send or 
press the Enter key on your keyboard. 

 

 To start Chat 

! From the Viewer window menu bar, select Tools, then Chat. 

The chat box will appear on both the Host PC and Client 
computer. 

 

 To end Chat 

! From either the Host or Client chat box, select File, then 
Close Chat. 

The chat box will disappear from both the Host PC and Client 
computer. 

 

 

 

Draw 

Draw enables you to use your mouse to draw and highlight on the screen.  

While in Draw Mode, you will see the term DRAW in the title bar of the Viewer, and the cursor 
will change to resemble a pen. You can draw on the screen by clicking and dragging your 
mouse; you can also highlight on the screen by holding down the Shift key on your keyboard 
while clicking and dragging your mouse.  

 

 To start Draw 

! From the Viewer window menu bar, select Tools, then Draw 
Mode. 

This will enable the Draw function. 
 

 To erase drawings 

! From the Viewer window menu bar, select Tools, then Erase 
Drawings. 

This will erase your drawings but keep you in the Draw mode. 
 

 To end Draw 

! From the Viewer window menu bar, select Tools, then 
deselect Draw Mode. 

This will cancel the Draw function. 
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Guest Invite 

The Guest Invite feature of GoToMyPC Personal enables you to invite a guest to view the 
desktop of your Host PC while you are physically present at your Host PC. 
 

 To invite a guest to your Host PC 

1. Right-click the  system tray icon and select Invite Guest to 
PC. 

2. When prompted, type in the email address of the guest you 
want to invite. 

3. Add to or customize the message that will be sent to your guest 
(optional). 

4. From the drop-down menu, select the time when the invitation 
will expire. 

5. Click Send. 

6. When prompted, enter the email address and password you use 
to log in to GoToMyPC. 

7. Click OK. 

Your invitation is sent to your guest, who will receive it via email. 
Click OK to close the send notification. 

 

Note: You must be at your Host PC to invite a guest to connect to it. After you send an invitation, you can cancel it by 
right-clicking the system tray icon and selecting Cancel Your Invitation. You can invite guests on any Operating System 
and GoToMyPC will provide the appropriate Viewer window for the guest’s Operating System. 

 

 

Connect to an invited guest 
To accept the invitation, your guest will need to click the activation link included in the 
invitation email. If your guest accepts within the time you allotted, you will receive this pop-up 
message on your screen: GoToMyPC: Guest has arrived, which will notify you that your guest 
is ready to join you.  

 To connect with the guest on your Host PC 

1. In the GoToMyPC: Guest has arrived message window, select the corresponding check 
box to give your guest view-only access or full remote control access to your computer. 

2. Click OK. 

A chat box will appear on your desktop and your guest will be able to view your desktop 
with a Viewer window on his or her desktop. 

 

 

Disconnect a guest 
You may disconnect a guest at any time. 

 To disconnect a guest from your Host PC 

! Right-click the  system tray icon and select Disconnect 
Guest. 
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Remote Printing 

Remote Printing enables you to print documents that are on your Host PC to your local Client 
computer printer. From your Client computer, you have the ability to print documents from a 
Host application that may not be installed on the Client computer. Once you have enabled 
Remote Printing, you can print a document from your Host PC to the Client computer printer 
by printing as you normally would.  

The process for enabling Remote Printing requires that you first set up the Client computer’s 
printer type on the Host PC. 

While you are remotely connected, you may enable Remote Printing from the Viewer menu bar 

or from the Preferences menu in the  system tray icon (usually located in the lower-right 
corner of your screen near the clock). 
 

Note: The add printer wizard will not be able to detect the type of printer if you attempt to install the printer from the 
system tray icon while you are not in session. The process of installing Remote Printing will vary depending upon 
operating system and access to printer drivers. If you do not have the necessary printer driver on your Host PC, you 
may need to download the driver from the manufacturer’s Web site before you can complete the installation of a 
remote printer. 

 

 To enable Remote Printing from the Viewer menu while remotely connected 

For Windows 2000, and XP 

1. From the Viewer window menu bar, select Tools, then Set Up Printer. 

The “GoToMyPC Personal – Select a printer to set up” window opens. 

2. On the “GoToMyPC Personal – Select a printer to set up” window, the drop-down menu 
will automatically select the default printer (from your Printers folder) installed on your 
local Client computer. If you wish to select another printer, click the drop-down menu 
and choose the printer you want to set up. 

3. Click OK. 

The “GoToMyPC Personal – Set up printer” window opens. 

4. On the “GoToMyPC Personal – Set up printer” window, check the box to “Install the 
printer automatically.” Click Next. 

GoToMyPC Personal will attempt to find the drivers for your printer and install them on 
your Host PC. 

•  If successful: You will receive notification that the printer setup was completed 
successfully. Click OK. The printer will be added to your GoToMyPC Personal 
printers list available on the GoToMyPC Personal Preferences menu. 

•  If unsuccessful: Repeat steps 1 to 3 and when you reach at step 4, uncheck the 
box “Install the printer automatically.” Click Next. 

5. The “Add printer wizard” window opens. Notice the GoToMyPC Personal “Add printer 
wizard” Tips window attached to the left of the printer wizard window. Please pay 
particularly attention to this menu during the setup process; it will provide assistance in 
setting up a GoToMyPC Personal printer. 

6. On the “Add printer wizard” window. Click Next. 

7. On the Select Local or Network Printer page, select Local printer. Make that Plug and 
Play auto-detection is NOT selected. Click Next. 

8. On the Select the Printer Port page, scroll down and select the GoToPort. Click Next. 

9. On the Add Printer page, select the manufacturer and model of your printer. Click Next. 
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Note: Start by selecting the manufacturer and then select the printer model that is closest to the model you 
have. If you cannot find a close match, you may need to download the driver from the manufacturer’s Web 
site. Once you have downloaded the driver (be sure it is the correct driver for your Host PC operating 
system), click the Have Disk button, browse to where you downloaded the driver, select the driver and click 
OK. 

10. On the name your printer page, enter the name for this printer. We recommend that 
you keep the “GoToMyPC” preface to the printer name to help you identify the printer in 
the future. Select No if asked to set this printer as the default printer. Click Next. 

11. On the Printer Sharing page, select Do not share this printer. Click Next. 

12. On the Print Test page, select Yes if you are remotely connected; select No if not. Click 
Next. 

13. Click Finish. 

 

 To enable Remote Printing from the Viewer menu while remotely connected 

For Windows 95, 98, ME and NT 

1. From the Viewer window menu bar, select Tools, then Set Up Printer. 

The “Add printer wizard” window opens. Notice the GoToMyPC Personal “Add printer 
wizard” Tips window attached to the left of the printer wizard window. Please pay 
special attention to this window during the setup process; it will provide special 
assistance in setting up a GoToMyPC Personal printer. 

2. On the “Add printer wizard” window. Click Next. 

3. On the select local or network printer page, select Local printer. Make sure that Plug 
and Play auto-detection is NOT selected. Click Next. 

4. On the Select the Printer Port page, scroll down and select the GoToPort. Click Next. 

5. On the Add Printer Page, select the manufacturer and model of your printer. Click Next. 

Note: Start by selecting the manufacturer and then select the printer model that is closest to the model you 
have. If you cannot find a close match, you may need to download the driver from the manufacturer’s Web 
site. Once you have downloaded the driver (be sure it is the correct driver for your Host PC operating 
system), click the Have Disk button, browse to where you downloaded the driver, select the driver and click 
OK. 

6. On the Name Your Printer page, enter the name for this printer. We recommend that 
you keep the “GoToMyPC” preface to the printer name to help you identify the printer in 
the future. Select No if asked to set this printer as the default printer. Click Next. 

7. On the Printer Sharing page, select Do not share this printer. Click Next. 

8. On the Print Test page, select Yes if you are remotely connected, select No if not. Click 
Next. 

9. Click Finish. 

 

 To enable Remote Printing from the GoToMyPC Personal system tray icon 

For all Windows operating systems 

1. Right-click the  system tray icon and select Preferences. 

2. On the Preferences window select the Printing tab. 

3. On the Printing tab click the Add Printer button. 
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The “Add printer wizard” window opens. Notice the GoToMyPC Personal “Add printer 
wizard” Tips window attached to the left of the printer wizard window. Please pay 
particular attention to this window during the setup process; it will provide assistance in 
setting up a GoToMyPC Personal printer. 

4. On the “Add printer wizard” window. Click Next. 

5. On the select local or network printer page, select Local printer. Make sure that Plug 
and Play auto-detection is NOT selected. Click Next. 

6. On the Select the Printer Port page, scroll down and select the GoToPort. Click Next. 

7. On the Add Printer page, select the manufacturer and model of your printer. Click Next. 

Note: Start by selecting the manufacturer and then select the printer model that is closest to the model you 
have. If you cannot find a close match, you may need to download the driver from the manufacturer’s Web 
site. Once you have downloaded the driver (be sure it is the correct driver for your Host PC operating 
system), click the Have Disk button, browse to where you downloaded the driver, select the driver and click 
OK. 

8. On the Name Your Printer page, enter the name for this printer. We recommend that 
you keep the “GoToMyPC” preface to the printer name to help you identify the printer in 
the future. Select No if asked to set this printer as the default printer. Click Next. 

9. On the Printer Sharing page, select Do not share this printer. Click Next. 

10. On the Print Test page, select Yes if you are remotely connected, select No if not. Click 
Next. 

11. Click Finish. 

Note: To use the Remote Printing feature, you will need to ensure that you have administrator rights when 
you upgrade/install GoToMyPC Personal if your Host PC operating system is Windows NT, 2000 or XP 
Professional. If you are on Windows 95 or 98 and upgrading to GoToMyPC Personal from a previous version, 
you may need to reboot your computer after upgrading to enable the Remote Printing feature. 
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Cut/Copy and Paste 

Cut/copy and paste enables you to cut/copy and paste text between the Host PC and Client 
computer. 

 To cut/copy and paste text 

1. Select the text you want to cut or copy by left-clicking you mouse and dragging the 
cursor over the text. 

2. Right-click your mouse on the selected text and choose Cut or Copy. 

3. Place your mouse in the location where you want to paste the text and left-click your 
mouse. 

4. Right-click your mouse and select Paste. 

 

Note: the cut/copy and paste feature has a text only maximum of 32kb of data. 

 

Desktop Shortcut 

Desktop Shortcut adds a shortcut to a Client computer that links directly to your Host PC to 
enable fast and easy access to the PC. Desktop Shortcut is convenient for users who frequently 
use the same Client computer to access the same Host PC (say from a home computer to a PC 
at work). 

 To create a desktop shortcut 

1. Log in and remotely connect to your Host PC from the 
Client computer on which you want to create the desktop 
shortcut. 

2. From the Client computer Viewer window, choose File, 
then Create Shortcut to “Host PC Name”. 

3. Click Yes to authorize creation of a desktop shortcut. 

4. Click OK. 

A desktop shortcut will be created on your Client computer 
desktop. 

 

 To access your Host PC using Desktop Shortcut 

1. From the desktop of the Client computer, double-click the 
GoToMyPC Personal Desktop Shortcut icon. 

Desktop Shortcut will open a Web browser and connect you to 
your Host PC. 

2. When prompted, enter the Access Code for your Host PC. 

The GoToMyPC Personal connection will begin. 

 

Note: The first time you use a shortcut from a Client computer, you will be required to authenticate your account by 
entering your email address and password. If this first-time log in is successful, subsequent uses of Desktop Shortcut 
on the Client computer will not require authentication. The Create Shortcut menu item on the File Menu will not be 
visible when a guest is connected to your PC during a Guest Invite session so that guests cannot create shortcuts from 
their computers to yours. You can revoke all shortcuts associated with your Host PC by clicking the Edit link on the My 
Computers page. For security purposes, moving or in any way modifying the shortcut will disable the shortcut’s 
functionality. 
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Remember Me 

Remember Me enables you to set a cookie in your browser that will automatically log you in to 
a specific GoToMyPC Personal account - without the need for you to enter your email log in and 
password – simply by returning to the GoToMyPC Personal Web site. 

 

 To enable Remember Me 

1. From the Client computer on which you want to activate the Remember Me feature - log 
in to your GoToMyPC Personal account. 

2. Click the My Account link in the left navigation bar. 

3. On the My Accounts page, click the Edit button. 

4. Click to select the check box for Remember Me. 

5. Click Submit to save your changes. 

Note: Use of the Remember Me feature requires that cookies be enabled for your browser (please see your browser’s 
Help for directions on how to enable cookies). To use the Remember Me feature, you must close your browser by 
clicking the “X” button in the upper-right corner of the browser window, or by choosing File then selecting Close from 
the menu bar. The Remember Me feature will NOT work if you click the Log Out link in the left navigation bar. 

 

 To disable Remember Me 

1. From the Client computer on which you want to activate the Remember Me feature, log 
in to your GoToMyPC Personal account. 

2. Click the My Account link in the left navigation bar. 

3. On the My Accounts page, click the Edit button. 

4. Click to clear the check box for Remember Me. 

5. Click Submit to save your changes. 

 

 

 

View Access Activity Report 

The Access Activity Report enables you to view your account’s connections for a selected date 
range. The report will tell you the source of the connection, the time it occurred, the client IP, 
the type of access and the duration of the connection. 

 

 To view the Access Activity Report: 

1. Log in to your GoToMyPC Personal account at www.gotomypc.com. 

2. Click the My Account link in the left menu bar. 

3. Click the Access Activity link in the left menu bar. 

4. Select the desired date for the access activity. 

5. Click the View Access Activity button. 
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One-Time Passwords 

The use of One-Time Passwords (OTPs) offers an additional level of security that can protect 
you while you are using public terminals that may have keyboard loggers or other keystroke-
capture hardware or software. Our One-Time Passwords system ensures that a discovered 
password is useless to the person who discovers it. 

One-Time Passwords are composed of six words, and each six-word combination provides one-
time access to a Host PC. Password lists are numbered in reverse order from highest to lowest 
and end in zero. 

The use of One-Time Passwords enables you to generate a list of One-Time Passwords that you 
will be prompted to enter after you enter your access code each time you access your Host PC. 

 

 

 To enable One-Time Passwords 

1. While physically present at the Host PC you want to enable for One-Time Passwords, 

right-click the  system tray icon and choose Preferences. 

2. Click the Authentication Tab. 

3. Click the Enable OTPs button. 

4. On the Generate One-Time Passwords dialog box, select the number of One-Time 
Passwords to generate (min. of 10, max. of 99) and click OK. 

5. On the Enter Access Code dialog box, enter the access code for the Host PC and click 
OK. 

6. On the Print One-Time Passwords List dialog box, select the font size to print and click 
the Print button. 

7. Verify your list of One-Time Passwords has printed and click Close. 

8. On the GoToMyPC Personal Preferences dialog box, click OK. 

You have now enabled use of One-Time Passwords on your Host PC and you will be 
prompted to enter an OTP next time you access your Host PC from a Client computer. 

 

 

 To access your Host PC using One-Time Passwords 

1. Point your Web browser to www.gotomypc.com. 

2. Enter your email address and account password and click Log In. 

3. If prompted, choose the account you want to access and click Go (only applies if you 
have multiple accounts associated with one email ID). 

This will load your My Computers page. 

4. To the right of the computer Nickname, click the Connect button. 

5. When prompted, Click Yes or Grant to download the GoToMyPC Personal Viewer. 

6. When prompted, enter the Host PC's Access Code and click OK. 

7. When prompted, enter the requested six-word One-Time Passwords and click OK. 

8. The Host PC image will appear in the Viewer window. 

You are now connected to your Host PC and are ready to begin accessing all your files, 
applications and email as if you were sitting at your PC! 
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 To generate a new list of One-Time Passwords 

1. While physically present at, or connected to, the Host PC for which you want to 

generate a new list of One-Time Passwords, right-click the  system tray icon and 
choose Generate One-Time Passwords.  

2. On the Generate One-Time Passwords dialog box, select the number of One-Time 
Passwords to generate (min. of 10, max. of 99) and click OK.  

3. On the Enter Access Code dialog box, enter the access code for the Host PC and click OK.  

4. On the Print One-Time Passwords List dialog box, select the font size to print and click 
the Print button. 

5. Verify that your list of One-Time Passwords has been printed and click Close. 

 

Note: You can generate a new list of One-Time Passwords at any time while still have OTPs available. Should you use 
all your OTPs before generating a new list, you will have to return to your Host PC to generate a new list or to disable 
One-Time Passwords. 

 

 

 To disable One-Time Passwords 

1. While at the Host PC for which you want to disable One-Time Passwords, right-click the 

 system tray icon and choose Preferences. 

2. Click the Authentication Tab.  

3. Click the Disable OTPs button. 

4. Click Yes on the warning dialog box that you want to disable One-Time Passwords.  

5. On the Change Access Code dialog box: 

•  Enter your old access code. 

•  Enter your new access code. 

•  Confirm your new access code. 

•  Click OK. 

6. On the GoToMyPC Personal Preferences dialog box click OK. 

Note: To help protect your security, you will be required to change your access code for your Host PC anytime you 
disable the use of One-Time Passwords. 
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Ending Your GoToMyPC Personal Connection 
Prior to disconnecting from your Host PC, you may want to first lock your computer to help 
ensure your security. 

 

 

Remotely Lock Your Host PC 

When you are through using your Host PC, we recommend that you lock your computer to help 
protect your data. Your operating system will dictate the method you will use to lock your PC. 

 

 To lock Windows NT, 2000 or XP Professional use the Lock Workstation function 

1. Complete all activities on your Host PC. 

2. From the Viewer menu bar, choose Tools, then Send Ctrl-
Alt-Del. Or click the Send Ctrl-Alt-Del button in the upper 
right-hand corner of the viewer window. 

 
This will bring up the Windows Security window. 

3. Click the Lock Computer button. 

Your computer workstation is now locked. 
 

Note: To use the Lock Workstation function, GoToMyPC Personal must be installed as a service. Installation as a 
service will require administrator rights for your profile. Please contact administrator for assistance. 

 

 To lock Windows 95, 98, Me or XP Home use Screensaver Lock function 

1. Complete all activities on your Host PC. 

2. Set your password-protected screensaver to start after one minute of inactivity.  

3. Stop using your Host PC until the password-protected screensaver engages. 

Your computer workstation is now locked. 

 

 

 

End Your GoToMyPC Personal Connection 

There are three ways to end your GoToMyPC Personal connection. 
 

 To end your GoToMyPC Personal connection 

! From the Viewer menu bar, choose File, then Disconnect. 

- Or - 

! In the upper-right corner of the Viewer window, click the  button. 

- Or - 

! Right-click the  system tray icon and select End Session. 
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Setting Preferences 
GoToMyPC Personal has several options that can be configured to suit your personal needs. 

 To set preferences 

1. Right-click the  icon in the system tray of your Host PC and 
select Preferences. 

- Or - 

Access Preferences from the Viewer Tools menu. 

2. Select the appropriate tab for the set of preferences you want 
to customize – Host Startup, Viewer or Security. 

3. Select your preferences. 

4. Click OK. 

 

Note: Your Preferences options may be affected by the type of operating system you are running and the type of 
rights your user account allows. Grayed-out options are not available for selection with your operating system or for 
the rights assigned to your computer profile. 

 

 

Host Preferences 

The Host preferences option enables you to configure settings for the Host PC. 

1. Choose how to start GoToMyPC: 

•  Run GoToMyPC Personal automatically: Start GoToMyPC Personal when you start 
your computer (default) or when you log in (optional for users with administrative 
rights). To ensure maximum availability of the Host PC, we recommend you choose 
to start GoToMyPC Personal automatically after startup. 

•  Run GoToMyPC Personal manually: GoToMyPC Personal will start only when you 
launch the application from your Programs menu. 

2. Choose to Enable Desktop Notifications and receive convenient notification of any 
important GoToMyPC-related information that is relevant for you. 

3. Choose desktop options while connected: 

•  Automatically adjust Host screen area for best full-screen viewing: If possible, it will 
resize the Host PC screen resolution to best match the Client computer resolution. 

•  Disable sleep mode on Host PC: Disables sleep mode so Host PC remains accessible. 

•  Show Host PC cursor: Enables the viewing of both Host and Client cursors. 

•  Show transparent dialog boxes: Enables use of transparent dialog boxes on 
Windows systems with that feature enabled. 

4. Authorization ID: Provides Host PC MAC Address and C: Drive Serial Number for use 
when Host PC authorization is required by administrators. 

 

Note: MAC addresses cannot be used for authorization when either the Host PC or Client computer connects to the 
Internet via a dial-up modem because, unlike with Ethernet and Wireless network adaptors, dial-up modems don't 
have MAC addresses. In these cases, using the C: drive serial number of the computer is the option if Host or Client 
Authorization is desired. 
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Viewer Preferences 

The Viewer preferences option enables you to configure settings for the Viewer window. 

1. Screen size: 

•  Start Host PC desktop in: Choose to start the Host PC desktop in either full-screen 
mode or in Window (in Viewer) mode. 

•  Show Host PC screen: Choose to view the host desktop image in actual size (may 
require scrolling in the Viewer) or scale-to-fit. 

2. Viewer options: 

•  Show update regions: Provides an outline around the area of the screen that is 
redrawn when your Viewer refreshes its image. 

•  Dim Viewer when inactive: Dims your Viewer window whenever you switch to your 
local Client computer window. 

•  Copy/paste between computers: Enables cut, copy and paste text between Host PC 
and Client computer 

•  Pass Windows keys to Host PC: Enables special key combinations such as Alt-Tab 
and Alt-Shift-tab, Windows key and Print Screen to be passed to the Host PC. 

•  Viewer color: Enables you to change the color of your Viewer window. 

 

 

Security Preferences 

The security preferences option enables you to configure additional security settings. 
 

! Lock upon Disconnection (Windows 2000 and Windows XP Professional users only): 
Automatically lock the Host PC when you end your GoToMyPC Personal connection. 

! Screen Blanking: Enables you to blank the screen of the unattended Host PC while you 
are remotely connected. 

! Keyboard/Mouse Locking: This security feature prevents others from using your Host 
mouse or keyboard while you are remotely connected. 

! Viewer Security Time-Out: Enables you to set the amount of time in minutes for the 
Viewer window to time-out if no mouse or keyboard activity is detected. Default for this 
setting is 15 minutes. 

 

Note: To maximize your security, we recommend that you enable all security settings. 
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Authentication Preferences 

The authentication preferences option enables you to configure settings for the Host PC access 
code, use of One-Time Passwords (OTPs), and configuring SecurID integration. 

1. Access Code: All users are required to have an access code for each Host PC. The 
access code is only stored on the Host PC and is never transmitted across the Internet. 

! Change Access Code: Enables you to change your access code by entering your old 
access code, entering a new access code and confirming the new access code.  

2. One-Time Passwords: Provides the ability to enable the use of One-Time Passwords and 
to generate password lists. One-Time Passwords is a secondary authentication method 
that requires you to enter a string of one-use passwords in addition to your access code 
to access your Host PC. 

! Enable OTPs: Turns on the requirement to use One-Time Passwords. 

! Generate OTPs: Generates a new list of One-Time Passwords. 

Note: To disable One-Time Passwords, you must be physically present at your Host PC and will be 
required to change your access code. 

 

 

Printing Preferences 

The Printing Tab enables you to add or delete printers and set the default printer you wish to 
use during a GoToMyPC Personal connection. 

 

Note: To simplify the remote-printer setup, we recommend that you configure a printer while connected to your Host 
PC from a Client computer. 

 

 

 

Connections Preferences 

The Connections Tab enables you to test the status of your Host PC connection. 

 

Note: To ensure a valid connection test, we advise that you refrain from testing your connection unless a GoToMyPC 
Personal customer-support representative directs you to perform the connection test. 
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Managing Your Computers 

Add or Remove Host PCs 

You have the option of removing and adding new PCs at any time, which gives you the 
flexibility to rotate Host PCs on your account.  

 To add a Host PC to your account 

1. Go to the PC you want to add to your account. 

2. Log in to your GoToMyPC Personal My Computers page. 

3. On the My Computers page, click the Add Computer button. 

4. Follow the normal process to download GoToMyPC Personal and register a Host PC. 

Note: Your ability to add PCs will depend upon the plan you have purchased.  

 To remove a Host PC from your account 

1. Log in to your GoToMyPC Personal My Computers page. 

2. On the My Computers page, click on the name of the PC you wish to remove. 

3. On the next page click the Delete button; this will remove the computer from the My 
Computers page. To remove the GoToMyPC Personal service from the Host PC, please 
use Add/Remove Programs feature on your Host PC. 

Note: You may add and remove Host PCs as often as you wish. You may also want to consider upgrading 
your account to allow for a greater number of PCs to be permanently available to you. 

 
 

Move Host PCs between Accounts 

To move a Host PC from one account (e.g., individual account) to another account (e.g., 
corporate account) you will need to uninstall and reinstall the GoToMyPC Personal software for 
each PC you wish to move. 

 To move a registered PC to another account 

Step One - Remove GoToMyPC Personal from your Host PC and My Computers page. 

1. First, delete the PC from the My Computers page for the account. 

! Log in to your GoToMyPC Personal My Computers page; on the My Computers page, 
click on the name of the PC you wish to remove; and on the next page select the 
Delete button. 

2. Then, remove the GoToMyPC Personal service from your Host PC. 

Go to the Host PC from which you want to remove the GoToMyPC Personal service and 
uninstall GoToMyPC Personal from the PC. 

! From the Task bar choose Start, then Settings, then Control Panel, then 
Add/Remove Programs and then GoToMyPC. 

Step Two - Add GoToMyPC Personal to your new Host PC and My Computers page. 

1. First, go to your new Host PC and download the GoToMyPC Personal software. 

! Log in to your GoToMyPC Personal My Computers page for the specific account and 
download and set up GoToMyPC Personal on that PC. 

2. When prompted, add the PC to your other account by registering the computer and 
using that account's unique email address and account password. 
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Change your Host PC Nickname 

You can change your Host computer’s nickname at anytime. 

1. Log in to your GoToMyPC Personal My Computers page. 
2. Click on the name of the PC you want to change. 
3. In the Nickname field, type in the new nickname and click the Rename button. 

The Nickname is changed. 

 

 

Forgot Host PC Access Code 

You may change the Host PC Access Code at any time. 

1. Go to the Host PC whose Access Code you want to change. 

2. Make sure that the GoToMyPC Personal service is running (look for  icon in the 
system tray). 

3. Right-click on the   system tray icon and select Preferences. 

4. Click the Security tab. 

5. Click the Change access code button. 

6. Click the Forgot it? link. 

7. Enter your Email address and account Password. 

8. On the change Access Code dialog box, enter your new Access Code, confirm the new 
Access Code and click OK. 

Note: You will need to be physically present at your Host PC to create a new access code because you will not 
be able to log in to your Host PC without knowing the access code for that computer. 

 

 

Forgot Account Password 

If you forget your Account Password, you will have to create a new Account Password. 

1. Go to www.gotomypc.com and click the Forgot Password? link below the log in box. 

2. Enter your email address that was used to create your account and click Submit. 

An email will be sent to your email address with a link to create a new Account 
Password. 

3. Go to your email and click the link to create a new Account Password. 

A Web page will generate for you to enter your new Account Password. 

4. Enter your new Account Password. 

5. Re-enter your new Account Password to confirm. 

6. Click OK. 
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What to Do When Your Host PC Is Offline 

If you log in to your GoToMyPC Personal account and see that the My Computers page is 
showing that one of your PCs is Offline, then one of three conditions, or a combination of 
conditions, may exist. The three conditions are: 

! The Host PC is turned off. 

! The Host PC is not connected to the Internet. 

! The GoToMyPC Personal service is not running. 

 

 To start the GoToMyPC Personal service 

From the taskbar, choose Start, then Programs and then GoToMyPC. 

What it means when your Host PC is In Session 

If you log in to your GoToMyPC account and see that the My Computers page is showing that 
one of your PCs is In Session, then one of three conditions, or a combination of conditions, 
may exist. The three conditions are: 

! The computer is a shared computer and it is being accessed by another user of the 
GoToMyPC account.  If you click the connect button you will disconnect the user that is 
in session with the Host PC. 

! You have not reloaded the My Computers page since you last connected to your host 
PC.  Click the browser refresh button to reload the page and the In Session notification 
should disappear. 

! The host computer has not yet set notification to the Citrix Online servers that it is no 
longer in session. Wait a few minutes and reload the My Computers page and the In 
Session notification should disappear. 

 

Reinstall GoToMyPC 

If for any reason the GoToMyPC Personal software on your Host PC is deleted or corrupted, you 
can easily reinstall GoToMyPC Personal at any time. To reinstall GoToMyPC Personal on the 
same Host PC, simply use the Add Computer function to download and reinstall GoToMyPC 
Personal and, when prompted for the computer name, enter that same name you previously 
used for that Host PC. 

 

Upgrade GoToMyPC 

GoToMyPC Personal will notify you when new updates are available. You 

can also check for new updates at anytime by right-clicking the  
system tray icon (usually located in the lower-right corner of your 
screen near the clock) and selecting Check for Upgrade.  

If a new version exists, you will be notified and asked if you want to 
upgrade. If you want to upgrade, click Yes: if not, click No. If you 
click Yes, GoToMyPC Personal will download the new version and 
prompt you to reinstall with the install wizard. 

Should the automatic upgrade fail, you will need to manually 
upgrade the service. Simply open a Web browser, go to 
http://www.gotomypc.com/setupSoftware.tmpl and follow the directions. 
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Access Online Help 

You can access product help at anytime by selecting the Help link from the Viewer menu bar or 

from the  system tray icon. 

 

Contact Customer Support 

If you are experiencing problems with GoToMyPC Personal or have questions, please contact: 

•  Customer support: gotocustomercare@citrixonline.com  

•  Billing questions: gotobilling@citrixonline.com  

•  Feedback or comments: gotofeedback@citrixonline.com  
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Safety Tips 
 

GoToMyPC Personal provides stringent built-in security features so that you can confidently 
access your PC from anywhere. For added security, here are a few things you can do. 

1. Keep Your Password and Access Code Secure 

•  Maintaining password security is the best way to protect your GoToMyPC Personal 
account and Host PC. Don’t share your password with anyone, and change your 
password regularly. You can change your access code from your Host PC by right-

clicking the  system tray icon and selecting Change Access Code. 

•  GoToMyPC Personal requires that your passwords have at least eight characters that 
include letters and numbers. When choosing your passwords, do not use common or 
easily guessed words. For the highest level of security, your account password and Host 
PC access code should be different. 

•  When using shared or public computers, exercise special care by not using GoToMyPC’s 
“Remember Me” feature to log in automatically. Additionally, you should not use your 
Web browser’s “auto complete” feature. 

•  Use the One-Time Passwords feature for additional protection when traveling and using 
public terminals.  

2. Protect Your Host PC When Remotely Connected 

•  Use the Blank Host Computer Screen feature to prevent someone at your Host PC from 
viewing your activity (most configurations). 

•  Use the Lock Keyboard and Mouse feature to prevent others from using your Host PC 
mouse and keyboard when you are remotely connected (this option available for most 
operating systems). 

3. Use Safety Features When Inviting Guests 

•  You choose the expiration period for each invitation so you know when to be available 
when your guest arrives. The invitation expires if the guest does not connect to your 
Host PC within your designated period. Because the invitation automatically expires, 
your guest cannot attempt to connect when you are away from your computer. 

•  You choose the level of access to grant your invited guests. To limit a guest’s access to 
your computer, grant view-only control. Alternatively, you can allow full control of your 
keyboard and mouse. 

4. Completely Disconnect 

•  Make sure to completely disconnect when you are finished by closing the Viewer and 
logging out of the GoToMyPC Personal Web site. 

•  Be certain that you do not leave the Client computer while you are remotely connected 
to your Host PC.  

•  When you log out, remember that if you do not close the programs you were last 
working on, they will remain visible the next time you access your Host PC. Make sure 
to close any sensitive documents or programs before you disconnect. 

•  If your Host PC is running Windows 2000 or Windows NT, you can optionally lock it 
when you disconnect from GoToMyPC. This prevents someone at your Host PC from 
using your computer after you have disconnected. Enable this feature from the Security 
tab of GoToMyPC Personal Preferences. 
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FAQs and Troubleshooting 
 

 

General FAQs 
 

Q. Can multiple accounts be set up on one host computer? 

A.  No. Multiple accounts cannot be set up on one host computer. If a computer is already 
registered to one account as a host and another user wants to add that same computer as 
a host onto his/her account, the first account will be overridden. In other words, the most 
recent user who added that computer to his/her account will have sole access. 

 

Q. I have two computers under my GoToMyPC account. Can I access both my 
computers at the same time? 

A.  Yes, a user may access two different computers at the same time. To do this, wait for a 
connection to be established on one computer and then go back to our GoToMyPC Web 
page and connect to the other computer. Please note that you may experience an 
increased lag time due to the multiple connections. 

 

Q. Is there a way to stop GoToMyPC from automatically launching? 

A.  You can start GoToMyPC manually by right-clicking the MYPC icon and choosing 
preferences. Under the Host Start Up tab, please choose the "Manually" selection, then hit 
OK.  

 

Q. Can GoToMyPC run without having the GoToMyPC icon active in the system tray? 

A.  GoToMyPC must be active in the system tray on the host computer for our users to use the 
service. 

 

Set Up FAQs 
 

Q. I tried to use your product, but cannot get past the window that asks for my user 
name and password. Help! 

A. In this case, you are stuck in the authentication loop. This usually means that the computer 
you are on is behind a firewall. Our product, currently, cannot get through some highly-
selective firewall systems. As a possible work-around, in addition to the usual ports 80 and 
443 that are used to access the Internet, we suggest opening port 8200. The IP address for 
GoToMyPC.com is 63.251.224.145. Make sure that no personal firewall software could be 
causing this also.  

 

Q. The GoToMyPC icon in the system tray has a yellow exclamation point. What does 
this mean?  

A. The yellow exclamation point generally indicates that you did not complete the set-up and 
installation process. Please right-click on our icon in the system tray and select “Register.” 
This will bring you back to where you quit. 
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Q. Sometimes your icon on the bottom has a red “x.” What does this mean? 

A. The red “x” means that your computer is not connected to the Internet, so you just need to 
log on. If the problem persists, please check to see if there is a firewall (personal or 
corporate) or proxy server. If it is a corporate firewall then escalate to the technical agents. 
If it is a personal firewall please instruct them on how to enable these programs to run with 
GoToMyPC. 

 

 

Session FAQs 
 

Q. I get horizontal lines on my screen when I access the host computer. How do I get 
rid of this? 

A. A user sees this image when his/her computer is scheduled to go into “Sleep Mode," has a 
screen saver on their system or has a DOS program open on their host PC. Click in the 
center of the viewer multiple times or access the Tools menu and select “Send file to 
remote computer” to wake up the computer. 

 

Q. How can I transfer more than one file at a time?  

A. You can choose more than one file at a time by holding down the Ctrl key while selecting 
files with the mouse. 

 

Q. The resolution is very bad. I can barely make out the icons on my desktop or read 
my email text. What can I do to clear this up? 

A. When a user is connecting to a host computer where the resolution is set higher than the 
client, GoToMyPC will automatically condense the host desktop image in the viewer. You 
can resize the image of your host computer's desktop by using the “View” option on the 
Viewer menu bar and selecting the preferred image size. You may also change host 
computers resolution.  

 

Q. I can’t send the Ctrl-Alt-Delete command to my host computer. I am on Windows 
2000/NT. 

A. This command cannot be sent unless the user has administrative privileges on the host PC. 

 

Q. I am getting a bluish screen or purple boxes on my screen when I connect. 

A.  Change your host PC image to 16-bit color. Click on the desktop and choose Properties on 
the Host PC. Then choose the settings tab and change the color to 16-bit and click Apply. 

 

Q. I cannot connect from my client machine.  

A.  Be sure to enable Java settings in the browser and then reboot. Make sure there are no 
personal firewalls on either side; if there are, be sure to enable GoToMyPC use with the 
software.  

 

Q. I have tried setting up my HP printer and I still cannot print. 

A.  Try installing the generic HP driver (LaserJet, OfficeJet, DeskJet, etc.) that comes up from 
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the list of manufacturers the operating system has in the printer setup and make sure to 
select the GoToPort as the port for the printer to use on the Host PC. 

Q.  I am running Windows XP and would like to switch users while connected to my 
host computer. Will I be disconnected or lose any information? 

A: GoToMyPC supports Windows XP Fast User Switching, allowing you to connect to your host 
computer regardless of which user (if any) is active at that time.  Once connected to your 
host computer, you can switch users at any time; however, any queued or active file 
transfers and remote printing jobs in progress will be terminated when a user switch is 
performed. To indicate that a user switch is taking place, a white screen with a status 
message will be displayed.  When using Windows XP Fast User Switching with GoToMyPC, 
we recommend that you avoid logging off your PC from the TaskManager Users Page as 
under certain circumstances, this may shut down GoToMyPC. 

 

Q.  Why are the letters the wrong case (Shift and/or Caps Lock do not work properly) 
when the Input Blocking feature is enabled on Windows XP? 

A.  Some versions of Windows XP have an issue with Input Blocking.  There are two ways to 
resolve this.  If you do not wish to update to Service Pack 2, go to Windows Update and 
install all of the Critical Updates.  Otherwise, install Windows XP Service Pack 2. 

 

PocketView FAQs 

 

Q.  How do I install GoToMyPC PocketView? 

A.  You do not need to install PocketView. Once you have set up a GoToMyPC account and 
installed the software on your Host PC, simply log in to the GoToMyPC Web site from your 
Pocket PC, Windows Mobile, or Windows CE device and choose the Host computer you wish 
to connect to. You will then be presented with the download needed to connect to that 
computer.  

 

Q.  Do I have to download PocketView every time I connect to my remote computer? 

A.  You must download the loader program each time you connect, but it is only 40KB. Once 
the correct version of the main PocketView program (about 400KB) is downloaded, it will 
be cached on your device so it will not need to be downloaded again. 

 

Q.  Can I pre-install PocketView? 

A.  PocketView is installed through download-on-demand. If you want to avoid going through 
the initial download while using a slower wireless connection, connect once while the device 
is in its cradle (using ActiveSync for the Internet connection). After that, the main program 
will be cached and will not need to be downloaded again.  

 

Q.  What kind of handheld device is needed to use PocketView? 

A.  PocketView can be used with Microsoft Pocket PC 2002, Microsoft Windows Mobile 
2002/2003/2003SE, Microsoft Windows Mobile 2002/2003/2003SE Phone Edition, and most 
devices running Microsoft Windows CE 4.0 or later.  

 

Q.  What kind of Internet connection is needed to use PocketView? 
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A.  An Internet connection with a typical speed of at least 40 kbps is recommended.  

 

Q.  How do I rotate the on-screen keyboard or other soft input panel? 

A.  If your device is running Windows Mobile 2003SE or later, you can rotate the screen using 
its built-in capability instead of using PocketView’s rotation.  From the Start menu, choose 
Settings " System " Screen to change the device’s orientation. 

 

 

 Q.  How do I remove PocketView from my handheld device? 

A.  If you wish to remove the cached PocketView program, use File Explorer to open the 
device's Temp folder; locate the g2viewer.exe file and tap-and-hold it; and then select 
Delete from the popup menu. 

 


